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This Brand New Step-By-Step Video Training System Shows 
Anyone To Go From Complete Newbie To Confident Photoshop 

Elements User In Just 2 Hours...

Click here to Discover this free video tutorial which shows you how to easily correct one of the most 
common graphic problems (I'm sure your computer is FILLED with graphics that have this problem 
and are dying to know how to fix it)... 

You’ll soon be able to edit your digital photos with fun and ease! - With these video tutorials (which you can 
watch online or download to your own computer) it's like looking over my shoulder as I show you how I 
create and modify all types of photos.

"Learn Elements Now" will teach you all of the following tools and editing tricks;-

... Find and view all my photos and video clips for quick editing

... Add backgrounds, shadows, and lighting to them

... Fix my common photography problems like red-eye, blurring, and color issues

... Crop and resize my photos without compromising quality

... Make my photos look their best with easy-to-use editing tools

... Easily perform more advanced retouching and enhancing thanks to the easy image-selection tools, and 
amazing compositing capabilities

Click Here to Master Elements In Just 2 Hours 
- Guaranteed (Even If You're A Total Newbie)!
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Photoshop Elements for Photography 
Enthusiasts

Photoshop Elements computer software is perfect for altering and applying special effects to 
your digital images as well as helping you prepare your photographs for the web. If you 
wish to resize your images, add filters and styles, Adobe Photoshop Elements is the 
software for you.

For the amateur photographer or the professional who is new to 
digital photography and computerized graphics, Photoshop 
Elements is easy to learn and comes with a low price tag and a 
host of creative tools that assist with manipulating and altering 
your images.

If you wish to retouch your image Elements has a huge variety of brush sizes available in 
Photoshop. Images can be altered by painting with the brushes over the area you want to 
change. Red eye can be removed in less than two minutes. If you have photos that have poor 
quality there is a sharp tool to sharpen certain areas of an image. You can even remove 
unwanted background items from an image.

Why Photoshop Elements Is The Perfect Fit
If you have been looking into editing your own digital photos you may find the variety of 
programs available for the purpose confusing. It can be 
hard to tell which program offers the best bang for your 
buck.

Widely reputed to be the best is the full version of Adobe 
Photoshop, unfortunately many of its features often go 
ignored by the average user. There are other quality 
programs on the market offered by less well known brand names.
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While these programs may be nearly as high quality as Photoshop it can be difficult to know 
which image editor offers good value and reliability and which is a waste of time. Luckily 
Adobe offers Photoshop Elements for those who want a known, high-quality image editing 
program, but don’t want to pay $500 or more.

Photoshop Elements has many of the same features as its namesake, Photoshop CS, and has 
the same user interface, but has a much lower price tag.

This sleeker, simpler version of the classic image editing program contains all the tools you 
need to easily edit and change photographs and graphics for home or small-scale 
professional use. It is perfect for the beginner as it has fewer confusing menus and high-end 
features, while still keeping a wide variety of useful tools.

The Importance of Composition
One of the most important elements of a good photograph is composition. Composition is 
basically the placement of the subject and objects in the photograph 
and how these elements interact with each other. 

Good  composition  is  what  distinguishes  good  photographers  from 
average ones. While there are a variety of aspects when talking about 
good composition, framing or cropping of an image is  an important 
part.

Photoshop makes it easy to improve the composition of a photograph 
through the use of the cropping tool. You can quickly remove parts of the photo that you 
either don’t want or that distract from the main subject. You can also make cropping as 
precise as you need it to be by measuring those areas to be cut.

The best part about using Photoshop’s cropping tool is that if you don’t like the result you 
can easily go back to where you started and try again. Essentially you can experiment with 
an unlimited number of possibilities.
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Turning Your Photographs into a Work of Art
Sometimes we take pictures and when we print them out we simply say, "Wow, that could 
almost  be  a  painting!”  Many  people  are  not  aware  that  there  are 
software programs that contain techniques that you can use to alter your 
photos into a watercolor or pen and ink painting or charcoal drawing.

Once you have changed your photo you then can print it out onto canvas 
or fine art watercolor paper for that true art feel and permanence. 

Photoshop Elements has several  tools that only require a little  bit  of 
time  and  experimentation  in  order  to  figure  out  how  to  use  them  to  enhance  your 
photographs.  Simply  by  adding  a  bit  of  "noise"  or  “Gaussian  Blur"  filters  to  your 
photograph can do wonders to transform your ordinary photo into a work of art.

Producing Creations in Elements
Making creations in Elements is as easy has dragging and dropping a few photos. The first 
thing you need to do is select your photos in your 
elements organiser and add them to an album, the 
easiest way to find them is through the Create Tab 
on the right hand side, if you would like to see 
more options just click the "More Options 
Button", the one we are looking for here is Photo 
Book, which you should find at the very top of 
the list.

When you are building creations in Elements 
you'll notice that it automatically switches to Full 
Edit mode. You'll see your photo bin at the bottom and the album you have created, if you 
want to change this just go back in to Organizer. You'll also see on the right the Create panel 
offers a choice random or user selected photo layouts, plus you also have a choice of 
themes, which are backgrounds and frame effects.

You also have a option which you can tick which say's "Auto Fill" this can be found within 
the Projects Bin Photos, once you have ticked that and press done this automatically 
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generates your Photo Book pages, you'll notice in Elements it has been scaled to fit the 
frame automatically. Elements also gives you a tool bar you can use this to navigate your 
book pages.

If you have done this with the "Auto Fill" and has given you two pages for your layouts you 
might find that there's some vacant space, you can drag another photo and just drop it into 
this layout. If you want to add more pages the tool has options which allows us to do this.

Using Elements to Restore Old Photos
Undoubtedly you have older photographs in albums or frames that have become damaged 
by the sun or general wear and tear.

Thanks to the technology available through the computer and photo 
editing software, including Adobe Photoshop Elements, it is easy to 
restore these cherished photographs.

Photoshop Elements is an easy to learn program. Using Elements you 
have options that can help restore your photographs. One of these 
tools is the Dust and Scratch Filter which can be used to remove any 
marks, scratches and blots on your old photos.

The Dust and Scratch Filter is found on the Menu Bar under the Filter Tab. A drop down 
menu lists your choices where you want to click on the Noise tab and then Dust and 
Scratches.

After selecting the Dust and Scratches menu, a pop up window opens with two control 
sliders. The first slider option is called the Radius and the other one is called the Threshold. 
If the preview box is checked you may also have another window open. The main options 
we use when restoring photos are radius and threshold.

Try to adjust the Radius slider which should remove any scratches. Please be aware that 
overdoing it may make the edges blurred as well. If blurring does occur you can adjust the 
Threshold slider. This should allow the details to return and make the picture clearer with 
the scratches disappearing. Also, be careful not to set the sliders too far or you will only 
create blotches on the picture.
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To get rid of any marks on the photograph you will want to highlight only the part of the 
photo where the scratches are located, not the entire photograph. To highlight these areas 
you can use the Lasso tool.

Once you have fixed the damaged areas you can use the feather tool to soften the edges of 
the selected area so that the fixed area will not be obvious on the picture. To use the feather 
tool you select the Feather option and choose the Scratch and Dust Filter again. You may 
want to do the radius and threshold adjustment process again to get the correct texture and 
make sure all the scratches and marks are removed.

To finish the restoration process and make the photograph appear professional I recommend 
you crop the image to remove any cracks or torn edges. You can also use the canvas to 
equally crop the image.

You can add drama to the picture by adding a drop shadow. This makes the photo appear as 
if it has been lifted off the page. You can also remove color from the photo using tools 
Shift+Ctrl+U. Once it is black and white you can then add color by putting a little amount 
of Sepia. This is done on the Hue or Saturation tab. The contrast may be adjusted using the 
Levels option.

This is only one very easy way to remove blotches and marks on an old picture. It is also a 
good way to make the picture look new but still appear classical. It will be a pleasant and 
easy way to display pictures kept on old albums and cabinets for a long time.

Restoring and Repairing Photographs
You may be considering whether or not you should restore your old photographs; if you are 
the first thing you must figure out is which problem you want to fix 
first. 

At times it is obvious to see which problem should be fixed first; 
some of your photos might have tears or a bad case of red eye.

However, some of your photos will undoubtedly have a variety of 
problems which must be corrected in the proper sequence so when you solve one problem 
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you may be correcting an entirely different problem at the same time. 

Fix Any Structural Issues 
Torn or ripped photos can be scanned in and repaired using Photoshop Elements tools so 
that you will have a whole picture to work with in order to correct other problems.

Contrast Issues 
Are your photographs too light or dark? This can be easily overcome using the 
brightness/Saturation levels in the Photoshop Elements toolbox.

Scrapbooking Pattern Layout Using Elements

Step One 
Under the File menu, select New, and then choose create a new Blank File.

Step Two 
Understand that the size you want to make your pattern will be the 
same size it will show up in your final product. Your resolution also 
needs to match the resolution of your final project in order to keep sizes 
exact. Typical standard resolution is 300 dpi, but for most scrapbook 
pages I recommend 200 dpi because you will have a lot of layers and 
your file sizes will get very large. When you are finished with your 
selections, press OK.

Step Three
When you create your own patterns your pattern might be as basic as a line down the middle 
of your new document; however for this example I want you to use the Custom Shapes tool 
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to create a more complicated pattern. Choose the Custom Shape Tool or press "U" on the 
keyboard. When you click on the Shape drop down menu you will see a small triangle to the 
upper right of the menu. Click on the triangle and more shapes will appear. For our example 
I want you to choose the category "Ornaments." This category contains a lot of shapes that 
are easy to repeat in a pattern. Choose the shape "Ornament 6".

Step Four 
Set the default colors to Black and White by pressing "D" on your keyboard. Now, click in 
the upper left corner of your blank file and drag your shape down to the lower right corner. 
You want to leave a little bit of room at the edges since this particular pattern needs a little 
space when it is repeated to look consistent.

Step Five 
The custom shape tool that we used creates a more advanced graphic that can be resized 
easily; however, before it can be used as a pattern it must first be simplified. Right click on 
the layers pallet, to the right of the icon, and select Simplify Layer or from the Layers menu 
select Simplify Layer.

Step Six 
Now you are ready to turn your shape into a pattern that can be used to fill a background. 
On the Edit menu select Define Pattern. A dialog box opens up asking for a name - type in 
any name that will mean something to you later and click OK.

Step Seven 
Now you can try out your pattern by creating a New Blank File - try 4 inches by 6 inches at 
200 dpi (the resolution we created the pattern in) and click OK. With the new blank 
document open, click on the Edit menu and then choose Fill. When the dialog box comes 
up, select Pattern from the drop down menu - the pattern you just created will be at the very 
bottom of the Custom Pattern drop down menu. Click OK and you will see how your final 
pattern looks!
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Making Canvas Photo Paintings in Elements
A canvas photo painting is the digital version of painting a photograph onto a canvas.

You have two basic ways to create a canvas photo painting: you can 
do it yourself or you can commission an artist to paint it. 

Obviously the least expensive way is to do it yourself. In order to 
convert a canvas photo to an art painting you will need to use photo 
editing software.

The best photo editing software available is without doubt Adobe Photoshop. Unfortunately 
the program is quite expensive. Adobe does, however, have a “light” version that you can 
use called Adobe Photoshop Elements. If you intend to create canvas photo art Elements 
works very well. You can download both programs for free for a one-month trial period.
Adobe Photoshop or Adobe Photoshop Elements uses filters which allow you to create 
different kinds of "paintings" such as Watercolor canvas photos or Sketch Drawing canvas 
photos. By playing with the different available filters you can choose which painting style 
suits you best. 

When you have chosen and applied the filter your canvas photo is ready and you can simply 
print it as a normal photo on canvas.

If you are looking for an actual canvas painting based on a photo you 
will need to find a reputable painter. 

Depending on which dealer you choose, the paintings will be created 
with either with traditional paint or on a computer. However, the 
photo should always be manually hand painted. No computer-
automated processes are used.

When using an actual painter you can have the photo painted in many different ways. You 
can choose between a modern and the classic look? It is up to you.

All artists have their own particular style - from Van Gogh to Andy Warhol. As you are the 
client the choice of style is up to you. If you want a style imitated most painters are very 
good to replicate the famous artists.

The normal material is oil painting if the painting is hand painted the traditional way. 
However, it does not have to be that way. You can also pick between charcoal, watercolor or 
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pastel. Even pencil and acrylic are possibilities.

Obviously you should be able to approve the painting prior to purchasing it. If you are 
dissatisfied the artist will make the wished changes.

Add A Quick Border Using Elements
When precision isn't important for the canvas-size enlargement, you can use the Crop tool to 
quickly add a border to an image. Here's how to 
do it.

1. Select the Zoom tool and zoom out by 
holding down the Alt key and clicking. 
The cursor will change from a 
magnifying glass with a plus sign to one 
with a minus sign. If necessary, click 
again until you can see some of the gray 
pasteboard surrounding the image. 

2. Select the Crop tool and drag a rectangle within the image—size doesn’t matter at 
this point. 

3. Drag the corner handles of the crop marquee outside the image area onto the 
pasteboard to define the size and shape of border that you want to create. 

4. After you have defined the new size for the image and border, click the Commit 
button on the tool options bar to apply the change. Or, click the Cancel button next to 
the Commit button if you don’t want to crop the image. The Background Color fills 
in the newly expanded canvas. 
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Reduce Red Eye in Your Photos
Everyone has become a victim to the curse of red eyes in our photos. More photos have 
been ruined with red eye than silly expressions, closed eyes, and blurred photos combined. 
Thankfully getting rid of red eye is a snap with Photoshop.

To fix red eye we will need to use the Layers Palette. You should be able to find the Layers 
Palette in the lower right hand corner of the window when you open Photoshop.

Once you have found the layers palette you need to find the adjustment layer button. This 
button can be found at the bottom of the window. To activate it, click on the adjustment 
layer button. A sub-menu should come up and you will want to select Channel Mixer. To fix 
the red eye you will want to set the Red slider to 0%, and the Blue and Green sliders to 
50%. Once you have done this click OK.

Set the foreground color to black at the bottom of the toolbar.In the toolbar, select the brush 
tool. Now, depending on the size of the photos, the red eyes might be too difficult to see; 
return to the toolbar and select the zoom tool (magnifying glass with a +). Clicking on the 
eyes with your mouse will zoom in on them. Once again return to the Layers palette. Select 
the layer Channel Mixer 1 by clicking it once.

Now you can use the brush tool again to paint the parts of the eyes that had appeared red. 
Return to the top of your screen click on the Image menu. Just like we did earlier you will 
need to move your mouse over Adjustments in the drop down menu. Select Invert in the 
sub-menu that comes up on the right. Tada … we fixed the red eye!
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How To Whiten Teeth Using Elements

Step One 
Open photo in Adobe Photoshop Elements

Step Two
Use the Zoom tool (circled in red at the left) to fill the screen with 
the teeth you will be working on.

Step Three
Polygonal Lasso tool settings We will use the Polygonal Lasso tool, set the settings to match 
the picture at left

Step Four
Selecting with the Lasso tool use the Lasso tool to select teeth. (The lasso tool works by 
starting at one point and doing quick click → release → drag → click → release → drag 
and clicks all the way around the object you want to select.)

Step Five 
Layer in the Menu at the top Click on "Layer" → "New Adjustment Layer" → 
"Hue/Saturation"

Step Six
New Layer box New Layer box will pop up, just press "OK"

Step Seven
Hue Saturation Menu on Yellows Hue Saturation Menu will pop up on the right. On the Hue 
Saturation Menu change to yellow and use the sliders to adjust the color of the teeth. Click 
"OK"
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Step Eight
White Teeth! You now have perfectly white teeth!

Healing And Cloning In Elements
Elements gives you the three different tool designs for 
removing unwanted blemishes, you can even remove 
very large objects in full edit mode. The three different 
methods are - Spot Healing Brush, Healing Brush and 
Clone Stamp Tool, each tools has its own benefits.

First the Spot Healing Brush does exactly what it says it 
does. This tool is great for removing spots whether they 
are spots made from your camera, facial blemishes or some unwanted object which you 
don't want in your photo.

Second is the Healing Brush, the healing brush is great for large areas, a great example here 
would be an unwanted plane flying in the back ground. Both the above tools are healing 
tools, the reason we use this tools for this type of method is because they blend the "healed 
area" with the surrounding pixels.

Third is the Clone Stamp Tool, this is used for more complex repairs like removing shadows 
from buildings or people.

While you're finding your way with the above tools you also need to know the shortcut to 
your brushes. This way you can speed things up. If you want ti increase the size of your 
brush all you need to do is tap the right square bracket key, this will increase it by one-pixel. 
If you want to decrease the size of your brush just tap the left square bracket, again this will 
reduce your brush size by one-pixel.
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Add Text To Photographs With Elements
Adobe Photoshop Elements is similar to the full version in a lot of ways, but a bit easier to 
learn. If you are just learning Photoshop you may want to experiment with some of the 
easier features to learn at first. Here is how you can add text to a photograph using Adobe 
Photoshop Elements.

Open the program and open your photograph within the program by going to "File," and 
then "Open." Locate your image where it is saved, and then click "OK."

Look in your tool box for the tool that is represented by the letter “T”. Click on it. This is 
your text tool. Mouse over to your image and click on it where you want the text to be. 
Note, you can move the text later if it is not in the right spot.

Select the font and size of your text from the horizontal tool bar across the top of the 
program window. You will see options with pull-down menus for font, size, centering, etc.

Look for the color square at the bottom of the tool box. Click directly on it to select a color 
of the text.

Type directly on the image whatever you want it to say. Save your image.

Go back to the tool box and click on the selection tool, which looks like an arrow. With the 
arrow selected you can click on the text and move it around the image until it is where you 
want it to be. Save your image again. 

Working With Photomerge In Elements
They say that sequels are never as good as the original - try telling that to Adobe. There 
fully revamped Photomerge now comes in three flavors and is ‘fully fantastic’. You get to 
explore the greatly improved Photomerge features only in Elements and Photoshop CS3. 

Photomerge is now capable of aligning and blending images without any signs of struggle - 
banding in smooth areas of tone. The fully revised Photomerge feature first made its 
appearance with CS3 but the maths seems to have got even better with the release of 
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Elements and the stitching is so clever it will really have you amazed at the quality that can 
be achieved inside this budget program.

The quality will be even better if you capture the component images of your panorama in 
vertical format (to reduce the effects of converging verticals) with a 50% overlap and you 
also use a manual exposure, focus and white balance setting on your camera (or process the 
images identically in camera Raw). The results will now truly be seamless - an excellent 
way of widening your horizons or turning your humble compact into a 30-megapixel 
blockbuster.

The Photomerge feature in previous versions of Photoshop Elements (and the full version 
for that matter) left a lot to be desired. All of the flaws and weaknesses of the original 
feature are now gone with the release of Elements.
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How To Sharpen Up Your Images In 
Elements

Another great feature within Elements is the adjust sharpness dialogue. You'll find this 
under enhance > adjust sharpness.

What you need to understand is this tool won't get rid of camera shake or bad focusing.

Once inside adjust sharpness you'll see the setting menu. The options are; amount, radius, 
remove. Remove has a drop down menu which gives you three options; Gaussian blur, lens 
blur and motion blur. Also you have a check box for more refined.

Again like everything else in Elements, to get the best results from your images or photos 
you'll have to play around with the settings. In the image below I have altered the image on 
the right with the adjust sharpening tool.
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Cropping Your Photos to Traditional Print 
Sizes

A important element when cropping your pictures is to check the size to make sure they will 
print in a standard size such as 4×6. If they do not correspond to traditional sizes try cutting 
a little more off. Otherwise when you take them into print at the local lab the photo lab may 
have to crop them even more to make them print the right size.

Photoshop truly makes it so easy to crop your photos digitally that you don’t need to worry 
about the framing when you take the picture on your camera because you can easily fix it 
later on your computer. Regardless of whether you use Photoshop Elements or the more 
advanced version, Photoshop CS, the technical aspects of using the cropping tool are 
essentially the same.

Backing Up Your Photos On Disc In Elements
As everyone knows backing up is one of the most important things you should be doing, but 
not many people do it. I’ll get straight to the point 
here, when your working with Adobe Elements you 
should be backing everything up, either with an 
external hard Drive, or a flash memory stick or to 
disc. You must also remember that it’s only a matter 
of time before your PC crashes.

So today I’m going to run you through the very 
quick process of backing your images to disc with Adobe Elements.

First I would recommend that you back up to DVD rather than a CD. Your first step is to 
select Organizer’s File Menu in the top right hand corenr and then choose Back Up Catalog 
to CD, DVD or Hard Drive.

You’ll than be given a dialog box, you are given some more options here, you can either do 
a full back up (you should do this option if it’s your first time) or you can choose 
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Incremental Backup (you only choose this after your first backup because this option only 
backs up your new changes from your last backup). So if it’s your first time make sure you 
choose “Full Back Up”.

The last step is very simple and straight forward. All you have to do now is click Next and 
your destination settings screen will appear, here you are telling Elements to backup your 
stuff. Now it’s up to you if you choose to backup to CD, DVD or external hard drive. Like I 
said before we are going to be doing this with a blank DVD, so you just need to insert your 
DVD and choose that drive from the list. Make sure you give your DVD a name and then 
click the Done Button and that’s it.
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Master Adobe Elements In Just 2 Hours 
With Breakthrough, Online Video Tutorials 

- Guaranteed (Even If You're A Total 
Newbie)! 

This brand new step-by-step video training system shows anyone how to go from 
complete newbie to confident Photoshop Elements user in just 2 hours...

Click Here To Receive A Free Sample Adobe 
Elements Video Tutorial Complements Of: 

www.LearnElementsNow.com
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